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What You Will Learn

» Concept behind Adobe Configurator.

= Install and launch Configurator.

= Installer on class CD - configurator_p1_111808.air — or online
at http://labs.adobe.com/technologies/configurator/

= Create a panel in Configurator using Tools, Commands,
Actions, Simple Text, and Feature Search Widgets.

= Export a panel to Photoshop and run it.

= See examples of what is possible using Configurator
and custom Flash Panels in Photoshop.
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Creating a panel in Adobe Configurator

All the pieces you need:

= Adobe Configurator

= Installer on class CD - configurator_p1_111808.air — or online
at http://labs.adobe.com/technologies/configurator/

=Adobe Photoshop CS4
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What is Adobe Configurator?

= It's a 'box of Legos" for Photoshop.

= Drag and drop tools, menu items, actions, scripts, and
prefab widgets (video, text, search, etc.).

= Don't just remix existing Ul elements: contextual them
in meaningful ways.
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Adobe Configurator - Demo

> 0 @& E ADOBE® CONFIGURATOR 1.0

Flle
Search

» TOOLS

T Configurator 1.0

v Ay S Create your own custom-designed panel for use in
=l S Photoshop CS4.

¥ WIDGETS

T B =
. Begin by creating a new panel (File->New Panel).

. Drag items you want to add to your panel from the area on the left, then drop
them inside the new panel.

. Use the controls on the right to customize the layout and functionality.
. When finished, export your panel (File->Export).

5. In Photoshop CS4, load your new panel from the Window->Extensions menu.
(Restart Photoshop after exporting your panel for the first time.)

Create New Panel
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Where To Go For More Help With Adobe Configurator

Panel Resources (seeclassCD ) :

= 0_PanelAndScriptingResources.pdf ( Handout )
= Links to Configurator Resources & 3™ Party Panels

= Configurator.mov (on class CD)
= 10 minute intro and demo of Configurator

= ConfiguratorKnownlssues.pdf (on class CD)

= ConfiguratorUserGuide.pdf (on class CD)
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Extending Adobe
Configurator with
Scripts

Jeffrey Tranberry
QE Product Lead, Photoshop




Tips For This Class

= We WILL be looking at javascript, HTML and XML code.

= Do NOT try and write down any of the code that you
see on screen.

= All the code you will see today is on the handout CD
and online at tranberry.com.




What You Will Learn

= What's is Scripting?

= Write some beginner scripts using the ExtendScript Toolkit CS4.
= Look at the Photoshop DOM.

= Create scripts to run from Configurator.

= Create a branded panel that relies on external resources.

= Create a cross-platform, installable .MXP file using Extension
Manager C54.

= Modify an .MXI file to install multiple files to multiple locations.
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Extending Adobe Configurator with Scripts

All the pieces you need:

= Adobe Photoshop C54
= ExtendScript Toolkit C54 (installed with Photoshop)
= Extension Manager CS4 (installed with Photoshop)

= Adobe Configurator

= Installer on class CD - configurator_p1_111808.air — or online
at http://labs.adobe.com/technologies/configurator/
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Creating Your First Panel

BeginnerScripts:

Delete all Channels

« Use the DOM to unlock new functionality.

Delete all Channels with 1 Undo

- Use suspendHistory to improve the user experience.
Super-Flatten

- Create a multi-step workflow for production: Flatten the
file, remove channels and paths.

Close All Docs Without Saving

« Use a while loop to process all open documents.

Stamp Visible

- Use the scripting listener to get at hard to find commands.
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BEGINNERSCRIPTS

[ <5 Delete all Channels

J

[ <5 Delete all Channels with 1 Undo |

[ <5 Super-Flatten

[ <5 Close All Docs Without Saving

[ <5 Stamp Visible

[ § Stamp Visitible to Top

| <5 Create New Curves Layer

| <5 Adjust Curves Layer

[ § Promote Background Layer




Creating Your First Panel (continued)

BeginnerScripts:
Stamp Visible to Top

- Add some additional conditionals to improve the user
experience

Create New Curves Layer
- Use scripting listener to unlock deprecated functionality
Adjust New Curves Layer

- Use scripting listener to unlock deprecated functionality
and add additional conditionals to improve the user
experience

Promote Background Layer

- Add even more conditionals to improve the user
experience
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BEGINNERSCRIPTS
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<5 Delete all Channels

J

[ <5 Delete all Channels with 1 Undo |
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<5 Super-Flatten
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<5 Close All Docs Without Saving
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<5 Stamp Visible
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<5 Stamp Visitible to Top
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<5 Create New Curves Layer
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<5 Adjust Curves Layer
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Creating Your Second Panel

PanosFX:

Brand a Panel o s

panosrx [N
- Add an image using relative paths.

- Add collapsed panel icons. P’\NOSF?S;‘.'Q:_‘.‘, @@

&

Understand the Configurator export process l < B&Big Picture Action |

Run and install an action
The B&BIg Picture turns your image into a

. . . . very impressive collage made up by 25
Understgnd error handling and load an action via a e Rk BaH ok T 2 Basdare
ExtendScript. style and appears to be slightly curved.

Add a button that launches a URL
| <5 Visit PanosFX.com |

- Reference and execute an external file using the
file.execute method in ExtendScript

Create an installer using the MXI file and Extension
Manager CS4
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Creating Your Third Panel

Airtight:

Reference external scripts

Modifying the MXI file to install multiple files
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AIRTICHT

RIRTIGHT

[ § SimpleViewer J

| <5 PostcardViewer J

| <5 AutoViewer |

[ 5 Tiltviewer |

[ § Visit AirtightInteractive.com J




What Is Scripting?

How is Scripting different from Actions?

- Actions are easy to use. You hit record, do your steps,
hit stop and play back.

- Actions while powerful enough for most users, are
basically “monkey see, monkey do.”
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What Is Scripting?

With Scripting you can:

Get information from Photoshop:
- Intelligent renaming of files
- Perform Conditional Actions

Process multiple Images:

- Process folders of images.

- Process all open documents.

- Create documents from scratch
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What Is Scripting?

With Scripting you can:

Process multiple parts of documents:
- Layers

- Comps

« Channels

Create text files with information from processed images:
. .csv/spreadsheets

« Xxml & .html

. .js/javascript
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What Is Scripting?

With Scripting you can:

Manipulate the file system:
- Create new folders.
- Open, save, copy, move, and load files.

Design User Interfaces:
- Create an easy to use interface for non-scripters.
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What Is Scripting?

Photoshop supports 3 scripting languages:

- AppleScript
« VB Script
- JavaScript

- AppleScript and VB Script are platform specific scripting
languages.




What Is Scripting?

Focus on JavaScript:

- JavaScript is NOT Java.

- JavaScript is not compiled.

- Requires only only a text editor to create.

- Like HTML, it's easy to start with templates, and/or learn
from someone else’s code.
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What Is Scripting?

Where do you begin scripting: Metaphors

Curves

: re :
Channel: RGB v (O—K)

[ Cancel

Load... ] f— )

Save...

Auto

( Options... )

VAV AV

™ Preview i

e,
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What Is Scripting?

Where do you begin scripting: Metaphors

"MAD&IBS

PiLoT TO PASSE"G:RS
A pirline’s Flight

Ladies and gentlemen, welcome aboard gwavd

+ HAIS IS your captain angd ilo ulie d
) pilot, = . We have
an T tailwind and will soon pe flying through a
beavy odad

e T Noun— Storm. So l'll,have to ask you all o fasten your
W s
ot : l"Rgells and ‘t-)r:”@ your trays to the -l::\%?

Position. In the meantime, I hope you haye a/an -\& trip

ADJECTIVE
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What Is Scripting?

Where do you begin scripting:
Learn Script Grammar

MADLIBS

World’s Sreatest Word Same

- You don't need to write the
whole story

- Only need to know a few
things about grammar:

- Verbs and Nouns
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What Is Scripting?

Where do you begin scripting:
Learn Script Grammar

« You don’t need to write an
entire script

- Nouns = Documents, Layers and
Channels ~)
 Verbs = Methods and Functions
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What Is Scripting?

Where do you begin scripting: Recipes

1 cup boiling water1 pkg. Strawberry JELL-O
2 cups mixed berries

1 pkg. (8 0z.) PHILADELPHIA Cream Cheese
1-1/4 cups cold milk

1 pkg. Vanilla JELL-O Instant Pudding

1 tub (8 0z.) COOL WHIP Topping, thawed1 pkg. (12 o0z.)
pound cake, cubed
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What Is Scripting?

Where do you begin scripting:
Reuse complex ingredients

Ingredients: sugar, gelatin, adipic acid
(for tartness), less than 2% of artificial
flavor, disodium phosphate and sodium
citrate (to control acidity), fumaric acid
(for tartness), and the colorant red 40.
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Writing Your First Script

Extend Script Toolkit CS4 (ESTK):

v

Macintosh:
Applications/Utilities/Adobe Utilities/ExtendScript Toolkit CS4

Windows:

C:\Program Files\Adobe\Adobe Utilities\ExtendScript Toolkit CS4




Where To Go For More Help With Scripting & Panels

http://www.tranberry.com/




Where To Go For More Help With Scripting & Panels

Panel And Scripting Resources:

= 0_PanelAndScriptingResources.pdf ( see class CD )
= Documentation
= Tutorials
= 379 Party Panels

= Configurator Resources

= Adobe User To User Forums

= http://www.adobe.com/forums
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Where To Go For More Help With Scripting

| LAY WO 18 WORK SAARTUN AN FASTLR TWAN £VES FR0M A PROTOSHOP WORLD INS TRUCTOR '
AND COMOST OF PHOTOSWOP TV, ONE OF TWE TOP- RANKID POOCASTS I TNE WORLD.

The Photoshop Speed Clinic:

The Photoshop CS2 Speed Clinic:
Automating Photoshop to Get Twice the
Work Done in Half the Time

by Matt Kloskowski
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Where To Go For More Help With Scripting

lynda.com .
products solutions resources about us news

Online Training Library™ » Adobe » Photoshop CS2 Actions and Automation

Photoshop CS2 Actions and Automation
with: Deke McClelland

Recording actions and automating common tasks saves time and makes performing repetitive tasks more
efficient. In Photoshop CS2 Actions and Automation, Certified Adobe instructor Deke McClelland teaches users
how to build actions more efficiently and reliably, identifies places where automation functions can be
improved, and provides an understanding of JavaScript commands to dramatically expand automation
possibilities. Better still, he discusses how to troubleshoot when things go wrong. The instructor also explores
the power of workspaces and batch processing, and describes Droplets inside out. The training shows how to
turn Photoshop into an industrious, image-crunching, timesaving tool -- and the instructor shares his top
insights and techniques. This training title offers expert guidance and instruction to prepare users to automate
common (and occasionally complex) tasks.
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Where To Go For More Help With Scripting

SEARCH INSIDE!™
“\-: Read Less Learn Mor
Adobe Scripting

/ J7

Adobe Scripting:

Your Visual Blueprint to Scripting in
Photoshop and lllustrator
by Chandler McWilliams

a——— ¥ . T T
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Creating a Custom
SWF Widget for

Jeffrey Tranberry
QE Product Lead, Photoshop

Tom Ruark

Senior Computer Scientist,
Photoshop




What You Will Learn

Create a new project in Flex 3.0.
Import an archived Flex Project.

Walk through MXML code for a simple RSS reader.

Walk through MXML code for a simple web hosted
training video.

Export a release build (optimized swf).

Integrate the swf widget into an Adobe Configurator
panel and run it in Photoshop.




Creating a Custom SWF Widget for Adobe Configurator

All the pieces you need:

= Adobe Photoshop CS4
= Adobe Flex Builder 3

= ( free 30 day demo available on adobe.com)
= Adobe Configurator
= SWF Widget source code ( see class CD)




Sample Projects Source Code

PS_Insider_RSS.zip

= Flex Project Archive

= (on class CD)

PhotoshopTV.zip

= Flex Project Archive

= (on class CD)
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Posts

Date

Now Read This Blog From Right Fri, 20 Mar 2009 07:01:18 +000 *

Follow-up to my Elinchrom BXRI Fri, 20 Mar 2009 06:37:26 +000 = |

My Day Shooting Tiger

Thu, 19 Mar 2009 06:26:48 +00

Thursday News Stuff (and some Thu, 19 Mar 2009 06:02:34 +00

It's "Guest Blog Wednesday"” fez Wed, 18 Mar 2009 04:01:16 +0(| v

On Tuesday I got lucky enough to spend the day shooting
Tiger Woods and some of the best golfers in the world at the
Tavistock Cup in Orlando, Florida. My buddy, and top-notch
sports shooter Mike Olivella, (who was covering the event for
AP}, was able to score me an “inside the ropes” all-access

media [...]

Read Full Post

Play

Photoshop TV

Pause Stop




Photoshop Insider RSS swf Widget

Using Flex 3.0:

= Source View - allows the user to create a panel using a
text editor.

= Design View - allows the user to create a panel using a
WYSIWYG interface.

DEMO
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Photoshop Insider RSS swf Widget

Flex Development - PS_Insider_RSS/src/PS_Insider_RSS.mxml - Adobe Flex Builder 3

J O 35~ Y=~ %o & J =1 i [ Flex Develop...
g Flex Navigator $2 | = B IBPS_Insider_RSS.mme X1 I5] states 52

= T 5] Source |[[] Design | <y & | Design area: Same as application size &

ID| <Base state> (start)

f7|3 PhotoshopTV
bin-debug
html-template
libs
7 (# src
B PhotoshopT'
[=] Flex Properties 53 C EE R =06

@ PS_Insider_RSS
bin-debug =]
so] mx:Application

bin-release
history
&% AC_OETags.. v 2
0 olayerProdul Horizontal align: -
@ PS_Insider_R Vertical align: 7]
Q PS_insider_R N
html-template
libs
Style:  <Default style> E]

w Common

w Style

r (2 src

4 PS_Insider_R (" Convertto Css... )

Read Full Post
=,
Text

[Z Problems &3 A z}
0 errors, 0 warnings, 0 infos

A Resource

C : : : :\ | Description
Border/Alpha

o= out... |8 co... ¥

Custom

Controls
Layout

Navigators
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Creating the Watermark Panel

Panel And Scripting Resources:

= 0_PanelAndScriptingResources.pdf ( see class CD)
= Documentation
= Tutorials
= 34 Party Panels

= Configurator Resources

= Adobe User To User Forums

= http://www.adobe.com/forums
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Creating a Custom
Panel in Flex 3.0

Tom Ruark

Senior Computer Scientist,
Photoshop




What You Will Learn

= Become familiar with the "Photoshop Panel Developer’s
Guide.”

= Create panels for Photoshop using Adobe Flex Builder
3.0.

= Take a step by step look at the MXML and Extendscript
code for the Watermark panel demoed at the Photoshop
World keynote.




Creating the Watermark Panel

All the pieces you need:

= Adobe Photoshop CS4
= Adobe Flex Builder 3

= ( free 30 day demo available on adobe.com)

= Photoshop Panel Developer’s Guide ( see class CD )

= http://www.adobe.com/devnet/photoshop/

= Watermark source code ( see class CD)




Creating the Watermark Panel

Chutes and Ladders:

Fx

Produces Produces
Adobe Flash JavaScript
(SWF) (JSX)

[
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Creating the Watermark Panel

Photoshop Panel Developer’s Guide:

= Sample Projects

= hello world

= color picker

= filters preview

= flickr search

= per layer metadata
= photoshop tv

= sample pictures

= shortcut buttons
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Creating the Watermark Panel

Photoshop Panel Developer’s Guide ( Cont.):

= Documentation
= Step by step instructions

= Excellent starting place
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Creating the Watermark Panel

Building the examples:

= Save directly to Photoshop

= Save to default then copy

= Adding in Watermark example
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Creating the Watermark Panel

MXML and Flex creates the SWF:

= Let's look at some code in Flex Builder 3.0
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Creating the Watermark Panel

JSX talks to the Photoshop DOM:
» DOM -Document Object Model

= app.documents.add();
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Creating the Watermark Panel

Build a Release version:

= Project > Export Release Build
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Creating the Watermark Panel

Panel And Scripting Resources:

= 0_PanelAndScriptingResources.pdf ( see class CD)
= Documentation
= Tutorials
= 34 Party Panels

= Configurator Resources

= Adobe User To User Forums

= http://www.adobe.com/forums

Copyright 2008 Adobe Systems Incorporated. All rights reserved. Adobe confidential.







Panel, Plug-In and
Scripting Workshop

Jeffrey Tranberry

QE Product Lead,
Photoshop

Tom Ruark

Senior Computer
Scientist, Photoshop




Panel, Plug-In and Scripting Workshop

= Now is a time for you to experiment writing your first scripts
and/or creating your own panels.

= Questions about creating panels?
= Questions about Scripting?

= Questions about developing plug-ins?
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